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INTRODUCTION AND DIRECTIONS FOR USE

Thank you for purchasing the Safescan TA-software. Combined with the TA-8000 series Time Attendance terminal it provides a complete
solution for efficient time registration. Before starting to install and use the software, we recommend that you carefully read this user
manual and keep it at hand for future reference. The user manual describes the basic set-up of the software, the advanced settings and
usage scenarios as well as details of each menu item of the device.

1. THE BASICS

1.1 MINIMUM SYSTEM REQUIREMENTS

In order to use the TA software, your computer needs to meet the following minimum requirements:

* Free hard drive space: 100 MB » Display resolution 1024 x 768
* Memory: 1GB e WIiFi or Ethernet (LAN) connection for real-time features.
* Operating System: Windows 7 * USB port

1.2 INSTALLING THE SOFTWARE

Download the software from the provided link, extract the .zip file and double click on taSetup.exe to run the installer. Follow the instructions displayed on
the screen, select the software language and the destination folder where you want to install the software.

1.3 ACTIVATING THE SOFTWARE

Differences between TA and TA+ software: “TA" is the regular time and License
attendance software from Safescan, providing you with all you need for
basic time registration and reporting. “TA+" offers additional functionality Enter license code
for more advanced needs, for example a graphical planning management _
tool and advanced work code functionality.
P Register

After installing, the software will run as TA+ version for 30 days. You can enter
your license key at any time. While in trial mode, the software will show the
license management screen upon start-up. If you have not entered a license key
after 30 days, the software will prompt you to do so in order to continue

using it. If you enter a TA license key, you will still be able to run the 30 day No license issued for this software
trial of the TA+, and see for yourself if it is worth upgrading.

Current license

Trial

You have 30 days left for evaluation

Trial TA Trial TA+

1.4 SCREEN LAYOUT MENU BAR

The menu bar at the top of the window gives
you access to all the screens of the software.

| 7% File Edit Report Help Menu Bar |

As with any standard Windows top bar menu, ¢
you can either make selections with mouse clicks N .
or by using the Shortcuts bar (also available TEEETE AT STree T R AETT 0 LT TR &=
through a combination of the ALT and another key). —————— = —_—
This bar gives you access to the mostly used Presence User. . Department User
functions of the software such as the reports, or the All - | All Bl Al 16 users - |
management screens.

(0] User name -« First name Last name Present InfOut

Bill Bill Wilson @ out

10 Brian Brian Jamefield (@ Out

8 Charlie Charlie Watson @ Out

1 Frederic Table Henrich @ oOut

3 Georges Georges  Harris @ Qut




141 TABLES

Tables. Many screens of the software display data in tables. These tables share common features.

Sort data

T4 File Edit Report Help

dule Planning

Report range Report from Report to

B 01/07/2014 B 31/07/2014 |
User Department User

All Bl Al 29 users |

Us... User name First name Last name Department When@ Device In/Cut Verify Mode Work code Remark
2 Eliott Marketing  30/07/2014 16:35:21 192.168.66.120 Fingerprint
2 Eliott Marketing  30/07/2014 16:35:00 192.168.66.120 Fingerprint
2 Eliott Marketing  30/07/2014 16:34:45 192.168.66.120 Fingerprint
2 Eliott Marketing  30/07/2014 16:22:10 192.168.66.120 Fingerprint
2 Eliott Marketing  30/07/2014 16:17:04 192.168.66.120 - Fingerprint

You can sort the data in the tables by clicking on the header of the column you want to sort. Another click will reverse the sorting order.

Rearrange column order
You can rearrange the column order in the tables by dragging any header to the desired location.

Toggle columns visibility
A right-click on any column will display a list of all columns available to display. Click on the column names you want to show/hide.
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2t Wheating AT S W W oe T Y EL ] v Department —
Personnel no
LS g ey WA e W 1" N oW LM .
v When
o gy s g AT R W . o oA om m Dat s+ wrnt
ate
2 e e | w9 . tia 1% e .- L Time P - et
ot ety AT Mive W T oW LN e v Device e s et
i T by LR T v In/Out k= T i
L bR Fre— A M w1 v Verify Mode )
Work code #
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1.4.2 FILTERS

You will find filters on most screens of the software. These filters will help you get relevant data in a quicker and more efficient manner. User text filter:
Enter the first letters of the name of the user you are looking for. Department filter: Gives you all data related to one chosen department. User filter:
Gives you all data related to one specific user. Report range filter: Select one pre-defined range, or click on “Select...” at the bottom of the list to
choose specific dates in the “Report from” and “Report to” filters. Report from filter: Select the start date of your report range (this filter is only enabled
if you have chosen Select..."in the “Report range” filter. Report to filter: Select the end date of your report range (this filter is only enabled if you have
chosen " Select..."in the “Report range” filter. Type filter: Present in the graphical screens (in Clock Grid as Report type, and in Planning as Planning
type). You can change the way graphical data is displayed on your screen. Day: Displays all days of the selected period on one line. Week: Displays the
days of the selected period one week per line, with Monday being the first column. Month: Displays the days of the selected period one month per line.




Month - Weeks: Displays the days of the selected period one month per line, also adds the day names. End of day filter: In the various report screens
of the software, you will find an “End of day” filter. It allows shifting of the end of the working day to a given time, providing easier reading of shifts going
from one day to another. For example: If the user finishes his shifts around 3 in the morning, set the “End of day” filter 04:00. If your users do not work
after midnight, leave the filter to 00:00.

1.4.3 MOST COMMON ICONS

You will find the following icons on several screens of the software:

1.5 LANGUAGE SELECTION

During the installation you were prompted to select the desired language. If the selection was correct, you can proceed directly to the next point. If you
wish to change your language, select File -> Preferences from the top menu (Keyboard shortcut: ALT + F + P). Select the desired language in the
language drop-down list.

Region

1.6 CONNECTING THE SOFTWARE AND THE TERMINAL(S)

The connection to your Time Attendance terminal can be set up from the ‘Device’ page in the software.




TA  File Edit Report Help

o FL D oI

Presence lock Jay Department User Workschedule Planning Device Worl

Name E (-E
Scan Add
Name IP address Active Fetcher Comm key Device Languagg

The TA software can communicate with your time attendance terminal by using a USB stick or by connecting your terminal to your network. When
connected to the network the user clocking data will automatically be transferred to the software. For data collection and user synchronisation via USB
please refer to the user manual of your TA terminal.

1.6.1 USB STICK

To set up the USB Stick please click on the “Add” button located on the top right of the page. This will open the following pop-up:

IP address of device

Fetching computer name

Communication key Device Language

Other B

Please specify a name for your device, then click on the ‘this computer’ button and select your language, if applicable*, in the ‘Device Language’ drop-
down list. The software is now ready to receive data from a USB pen drive. */f your required language is not present in this list then select ‘Other’

1.6.2 NETWORK

To set the IP address on your Time Attendance terminal please refer to the user manual of your TA-terminal. Setting up a connection to a network-
connected Time Attendance terminal is an automated process.

Simply click on the “Scan” button on the top right of the page and a pop-up displaying the IP address of your terminal will appear on
the screen.



Click ‘Yes' to establish connection between the device and the software.

The device will appear as connected on the page. To edit the terminal information (e.g the name), simply double click on the connected device and you will

be able to edit any of the given fields.Your terminal is now connected to the software.

T4 File Edit Report Help

> 3 | \j Safescan

Presence ock 0 Y Period Report e 1] 8 ‘ ule Planning

8 o a0
Scan Add Edit Delete Refresh

Name IP address Active Fetcher ‘Comm key Device Language

192.168.66.114 192.168.66.114 Connected OFFICE-PC Other

o JQ

_ . Synchronize
Settime  Synchronize yorkcodes

1.7 CREATING DEPARTMENTS

Creating departments will, especially when managing a large amount of users, help you manage them and their clocking data more effectively. It will also
allow you to generate reports on specific groups of users or departments.

In the top menu, select Edit -> Department, or click on the “Department” icon in the shortcut menu bar (keyboard shortcut: ALT + E +

On the ‘Department’ page in the software you will find one default department. Both the name and description are defined by a question mark. You can
edit this by double clicking the line or by following the steps below.

14 File Edit Report Help

=n —
d

orkcode
Presence Clock Clock Grid lay Period Report Report Department

Name Description
Name = Description
? ?

Click on the department line, the background changes to blue, then click on the edit button and a new window will pop-up.



Name Description

f ?

Change the name and the description, and click on ‘OK.

To add more departments, click on the “add” button located at the top right of the page and fill-in the details in the pop-up window,
saving each time by clicking ‘OKk.

1.8 CREATING USERS

There are two ways of creating a new user. You can either start from the software or from your Time Attendance terminal. Even though you can use both
ways, we would recommend you start from the TA device, since it minimises the chance of mistakes and prevents the mix-up of user data.
Please note: After every change you have made to the users, you will need to synchronise the software with the device.

1.8.1 STARTING FROM THE TERMINAL

Register the user on the device (as explained in your device manual) and make sure that communication is established between the software and the device.

. Go to the ‘Device’ page (ALT + E + E) and select your device.
||
||

T4 File Edit Report Help

— R : - @Safescan

Presence Clock G Jay Period Report " Department User e Device ode

8o a®o
Secan Add Edit Delete Refresh
Name IP address Active Fetcher Comm key Device Language
192.168.66.114 192.168.66.114 Connected OFFICE-PC Other

o S

Synchronize
Set time SYnchronize oy,

Click on the ‘Synchronize 'button at the bottom left of the page and a new window will pop-up displaying the differences between the
Q& data in the software and on the device.
o

Send the data from the terminal to the software by clicking on the ‘TA > PC' button.

Validate your choice by clicking on the “Commit” button.

<

The software will now check again for differences. If no difference is found, it will display the message ‘No changes found' Your user(s) is now
synchronised with the software and the device.



Go to the User page (ALT +E+U) to edit the user data.

L

" File Edit Report Help

SIL 3 = @)Safescan

e
Presence Clock Clock Grid Jay Period Report User Work Schedule  Planning Device Workcode

User... Department User @ M @ 0
All B 1: Frederic B
Export Mail Print Add Delete Refresh
D a User name First name Last name Department RFID Mo Privilege
1 Frederic ? Supenvisor
[T

User IO Int. email Privilege Status
1 Supenvisor B Active - |
L

User name Work schedule RFID No Fingerprints o

. ange
Frederic B o Absent
Department Int. phone ®
? ]

Delete

Select the user you want to edit and click on the ‘Edit button.

4

The ‘System Data’ tab shows the minimal amount of data you need to set in order to have your user recognised correctly by the TA terminal.

£&a 9

Save Cancel
User ID Int. email Priviege Status
1 User B Active |
K
User name Work schedule RFID No Fingerprints

Change

III IEI Ho . Absent
Department Int. phone ®
? Change password...
= &= Delete

User name: this is the name that will also be displayed by the TA terminal; it can be a maximum of 8 characters long.

Privilege: the default value is ‘user’, you can change it if you want to grant more rights to the user.

Status: make sure it is set to ‘active’.

RFID Number: When applicable, fill-in the number written on the RFID card (when printed) that you want to link to the user.

Password: You can set a password for the user. This will allow him/her to login in the software or to clock on the TA terminal. When creating a user
inthe software, the value of the password is the same as the given user ID. If you also want to use the password on the TA device it must be numerical
only and no longer than 5 digits.

6. Work schedule: You can link the employee to a work schedule (see section 4 of this manual).

E ! When finished, click on the “Save” button.

SIS




1.8.2 STARTING FROM THE SOFTWARE

Go to the ‘User’ page (ALT + E + U), and click on the “Add” button located at the top right of the page.

[~ File Edit Report Help

I T & = @Safesoan

Workcode

Presence Clock Clock Grid Day Period Report Report Department User Work Schedule Planning Device Workcode
User.. Department User
: @ = S (%
All B Nousers |
Export Mail Print Add Refresh
D a User name First name Last name Department RFID No Privilege
1 T |

The following pop-up will appear:

User ID Department

i Design |

The software automatically selects the next free user ID. It is possible to change the user ID, however due to the way the software and the clock
communicate we strongly recommend you to keep the designated User ID. Select a department for your user from the drop-down list, and click on OK.
You can now enter the user data.

About User ID'’s: The terminal and the software make use of user ID'’s to retrieve user information. We recommend that you do not change the

automatically allocated ID’s. If you want re-use some company specific ID’s, please use the “Personnel No” field in the software.

=

When finished, click on the “Save” button.

You now need to send the user data to the Time Attendance terminal. Go to the device page (ALT + E + D), and select your device.

Click on the “Synchronize” button at the bottom left of the page and a new window will pop-up displaying the differences between the
Q& data on software and the device.
<

=] Send the data to the terminal by clicking on the “PC > TA" icon.
=) =
]

I&I Validate your choice by clicking on the “Commit” button.

Your user is now synchronised from the software to the terminal. When applicable, if you want to register fingerprints for your users, please refer to the
user manual of your TA terminal.



Please note: If have created a user with more privileges than normal user privileges - either in the software, or synchronised from the device -, the

software will prompt you for a username and password at startup.

\%) Safescan

Forgot password...

1.9 WORK SCHEDULES

Depending on the use of fixed or variable work schedules with your company the TA software provides you with two ways of applying schedules to

your members of staff. If your employees work with regular work schedules that do not vary from week to week, follow the instructions below. If you
require more flexibility or variation in the work schedules due to changeable work patterns and/or day- and nightshifts: this will be covered in the chapter
“planning” It is still advisable to follow the instructions below as the regular work schedules share many similarities with the variable schedules.

In the top menu, select Edit > Work Schedule, or click on the “Work Schedule” icon in the shortcut menu bar (keyboard shortcut:
ALT + E + O).

Click on the “Add" button located on the right at the top of the page.

Fill-in the name and the description for your work schedule in the pop-up and click OK. At the bottom of the page the following field will become visible.

Name Description

Standard Regular 9-5

As an example we will use the following schedule. The employees work Monday to Thursday from 9:00 to 17:00 and from 09:00 to 15:00 on Friday's.
Every day they clock for their lunch break from 12:00 till 13:00.

9

Cancel

Name Description
Standard Regular 9-5
Day of week Start type Start time | Round bef...| Round after | End type End time Round bef...| Round after | Effective

00:00




By clicking in the ‘Day of week’ cell a day selection drop down becomes available to select the required days.

Day of week

Start

Monday; Tuesday; Wedn B3| In

¥ Monday

¥ Tuesday

¥ Wednesday

¥ Thursday
Friday
Saturday
Sunday

The start type automatically defaults to ‘In’. For our example the start time is 09:00 and the end time is 17:00.

£a 9
swe  Cancel
Name Description
Standard Regular 9-5
Day of week Start type Start time Round before Round after End type End time Round before Round after Effective
Mon; Tue;Wed; Thu In 09:00 Out 17:00 08:00 * 4
32:00
As the working hours for Friday differ from the rest of the week we need to create a second line with hours from 09:00 to 15:00.
Save Cancel
Name Description
Standard Regular 9-5
Day of week Start type Start time Round before | Round after | End type End time Round before| Round after | Effective
Mon; Tue;Wed; Thu In 09:00 Out 17:00 08:00 * 4
Fri In 09:00 Qut 15:00 06:00
38:00

To set up the ‘clocked’ lunch break we will set up a third line. As the employee(s) go to lunch at the same time every day we can use one line even though
the start and end times of the day vary. We will indicate that employees have a clocked break between 12:00 and 13:00. First we select the days from

Monday to Friday, then we will change the start type* to ‘Excl break’ and fill-in the start time and the end time.

Save Cancel

Name Description

Standard Regular 9-5

Day of week Start type Start time Round before  Round after | End type End time Round before | Round after | Effective

Mon; Tue;Wed; Thu In 09:00 Out 17:00 08:00 * 4

Fri In 09:00 Out 15:00 06:00

Mon; Tue;Wed; Thu;Fri Excl break 12:00 Break return 13:00 01:00 * 5
33:00

=

Our work schedule is now completed; we can save it by clicking on the “Save” icon at top of the schedule. If the icon stays inactive, it
means that there is a conflict in the schedule that will need solving.

* Regarding the start types: There are four different start types: In: used to notify the start of the working day. Break Incl: Is used if the breaks are part
of the working day. This is for information purposes only and has no impact on the total worked hours. Excl break: Use Excl break when employees

clock in and out for their break. Break impl: Is used if you want break(s) to be deducted automatically from the total worked hours without the

employees clocking for it.




1.10 WORK CODES

Work Codes are a key element of the TA+ software, and they can be used for several different purposes. They can be used to specify time spent on
specific projects but are also used in absence registration.

o — In the top menu, select Edit -> Work Code, or click on the “Work Code” icon in the shortcut menu bar (keyboard shortcut: ALT + E +

E W).

The software has some pre-defined standard work codes. These can be edited and customised to suit your own needs when required.

L G5 &

Presence k lay Period Report ! c Department User Work Schedule Planning Device Workcode
Name Description @ ’X‘ @
Export Wail Print Add

D - Name Description Color

1 Project Assignment time [ ]

2 Planned Scheduled time [

3 Vacation Vacation time

4 Haliday Haliday time [ ]

5 Vac.P Planned Vacation time [ ]

6 Deplan Unplanned time [ ]

7 Sick Sick [

To add another work code, click on the “add” button located on the top right of the page and a window will pop-up.

Workcode MName
g
Description
Work code type
Scheduled time [~ |
Regular out M 5iack [~ |

Explanation:

Work code: This is the work code ID, it is not necessary to change it but it is possible to change it (e.g to reflect an account or job number).
Name: The name of the work code (this field is mandatory).

Description: The description of the work code (this field is mandatory).

Work code type: There are several different work code types. The impact they have on the counting of hours varies from type to type. This will be
explained in detail in the “planning options” section. When creating regular work codes, use ‘Scheduled time'.

Regular out: Allows the software to understand the work code has been used to indicate the end of the day.

Colour: Change the colour of the work code in the planning and the Clock grid.

To sum up: when creating a regular work code: fill-in the name, the description and choose a colour.



1.10.1 REGULAR OUT

Workcode Mame
8

Description

Work code type
Scheduled time

Regular out {]Aqua

Workcode MName
17 Qutside
Description

Outside mission

Work code type

Assignment time

Regular out

When a user clocks out using a work code, the software considers that the user is still working. Using a work code with “Regular out” checked allows to
signify that the user is not working anymore. This option can be used for leaving early during work time. Example: We will use two work codes to illustrate
this functionality: The first work code is used for work done outside of the office. The second one is used for leaving early, “Regular out” is checked:

Workcode MName

18 Early L|

Description

Early Leave
Work code type

Scheduled time [~ |

v Regular out [ Aqua [~ |

oK Cancel

Let's review the following actions for a user with a work schedule running from 9 to 17:30 with an Implemented Break between 12 and 12:30:

User ID First name Last name Department When Device InfCut Work code
2 Paul Manfred Management 13/08/2014 09:00:00 TAB035 In
2 Paul Manfred Management 13/08/2014 15:00:00 TA 8035 Cut Qutside
2 Paul Manfred Management 14/08/2014 09:00:00 TA 8035 In
2 Paul Manfred Management 14/08/2014 15:00:00 TA B035 Cut Early L
13-08 Wiad 00 12000 g:00a 500 . =16:00 = | Cutside, Corrected by system
12:30 17:30
14-08 Thu S:00 12 00y g:00 530 =21 30 =18:30 =|Early L
12:30 15:00

On the first day(13/08), the user has clocked out at 15:00 with the “work outside office” work code ( “Regular Out” not checked), the day is automatically
closed at 17:30 (time of the work schedule) and 2:30 hours are counted as work outside of the office in the work code report.

Report range Report from Report to End of day Work code filter
This week B 11/08/2014 B 17/08/2014 B 12:00 B 17 Outside v |
Filter user... Department filter User Filter Grouping
2 All Bl ANl 2users B No grouping ~ |
User D First name Last name Department Date Work code # Work code Time
2 Paul Manfred Management 13/08/2014 17 Outside mission 2:30

On the second day(14/08), the user has clocked out at 15:00 with the early leave work code (“Regular Out” checked), we can see on the report that this
results in a negative balance of 2:30 hours.




2. ADVANCED USAGE SCENARIOS (TA+ SOFTWARE VERSION ONLY)

2.1 PLANNING (TA" SOFTWARE VERSION ONLY)

Chapter 1.9 covered the creation of a work schedule for employees with regular work schedules. We are now going to create a planning with flexible
schedules for our employees. You can create a planning by assembling various templates. These templates are created by the association of a time plan
and a work code. We will take the example of a company where employees can work 3 different shifts. One shift runs from 8:00 to 17:00 with a clocked
break from 12:00 to 13:00. The second shift runs from 17:00 to 01:00 with a break from 21:00 to 22:00, and the third shift runs from 01:00 to 08:00
without break. Firstly, we will create three different work codes, one for each shift.

Workcode Workcode Name
8 9 Evening
Description Description
Day Shift Evening Shift
Work code type Work code type
Scheduled time [~ | Scheduled time
Regular out Regular out M Biue ~|

Workcode Name
10 Might

Description

Night Shift
Work code type
Scheduled time

Regular out [ Fuchsia [~ |

Let's create templates for these shifts. Go to the ‘Planning’ page (ALT + E + P).

TA  File Edit Report Help

fid -_ e D 4 = @Safesoan

code
Presence Clock Clock Grid day Period Report 0 © User Work Schedule Planning Device Workcode
Planning mode Planning horizon from to
b ® 3
Users Next manth B ovorzm4 B 3072014
User.. Department User Mail Add Refresh
Al B 1: Frederic | -—
Planning type Planning view ﬂ
Day H View List Report  ad<br=Holiday Time plan Work code
User name 01/07... 02/07... 03/07... 04/07... 05/07... 06/07... 07/07... 08/07... 09/07... 10/07... 11/07... 12/07... 13/07... @ 4:| g
1 Frederic
Add Undo plan Save plan
Mame = Time plan Workoode

On the right side of the screen, you will see an empty table, click on the “Add” icon to create a new schedule template.

@ py

Add Undo plan Save plan

MName Time plan Workcode

Enter a name for the template (in this case Day), then click on the “Edit” button. A new window will pop-up.




You can fill-in this window in the same way you filled-in the work schedule which was covered in Chapter 1.9.

Mon; Tue;Wed; Thu;Fri

@.@ < g
Add Delete  Undo plan Save plan

Click on ‘OK’ to save. Select the ‘Day’ work code you have created previously in the work code drop-down list.

We can proceed the same way for the two remaining shifts (Evening and Night).

Mon;Tue;Wed; Thu;Fri| In
Mon; Tue;Wed; Thu;Fri| Excl break

Mon;Tue;Wed; Thu;Fri| In
Mon;Tue;Wed; Thu;Fri| Excl break




Add
Mame - Time plan Workcode
Day Schedule Day
Evening Schedule Evening
Might Schedule Night

Select days on the planning at the left side of the screen, and simply drag and drop the desired template. A window will pop-up giving you the option of
leaving feedback on your operation, you can still change the associated work code or cancel the operation. Click ‘OK’ to save.

Description

Day - |

02/07/2014 08:00 - 12:00: 1 John
02/07/2014 13:00 - 17:00: 1 John

03/07/2014 08:00 - 12:00: 1 John
03/07/2014 13:00 - 17:00: 1 John

Planning mode Planning horizon fram to %
Users Next month B o1or2014 B 31072014 ’A‘

User... Department User Mail

All B 1:John - | —

Planning type Planning view =
Month - Weeks B - | Ve
User name lun. mar.  mer.  jeu. ven. sam.  dim. lun. mar.  mer.  jeu. ven. sam.  dim. lun. mar.  mer.  jeu. ve
1 John 30/06 0107 0207 |03D7. O04/07. 0507 06/07. |07/07 | 08/07. |09/07 . |10/07. 1307 |12/07 . 1307 1407 15/07. |16/07  17/07 . |18,
Juillet

Repeat the procedure until you are done with the planning.

Work code types (TA+ software only): There are 7 different types of work codes, which all have a different impact on the calculations in the software.
Scheduled time: Regular working hours. Assignment time: Can be used for assignment to projects. Calculated as normal hours. Can be filtered in
the planning screen. Vacation time: The hours of the existing work schedule of the user are converted into vacation hours, they are deducted from

the vacation hours total. Planned vacation time: To be used to enter vacations for users without regular work schedules. Holiday time: National
holidays, reported as paid days. Unplanned time: Cancel an existing work schedule. It is possible to add Scheduled time or Assignment time over
Unplanned time. Sick: Work code type for sick leave, reported as paid time.

2.2 NATIONAL HOLIDAYS AND VACATIONS (TA™ SOFTWARE VERSION ONLY)

2.2.1 NATIONAL HOLIDAYS

The planning of national holidays is a straightforward process. Go to the ‘Planning’ page (ALT + E + P) and click on the ‘import holidays’
£ button located on the top right hand side of the page.



Select your country in the drop-down list of the window that just popped-up. Leave the default selected work code. Validate your choice by clicking ‘OK’.

Country f Region

k;erman, Berlin

Workcode
Holiday |

Please note: If you have deleted the “Holiday” work code from your work codes list, please create a new work code with “Holiday time” as work code
type before importing the national holidays.

2.2.2 VACATIONS

Planning vacations will differ depending on your employees working with a regular working or planning schedule. Employees with regular work schedule

@l®‘3e

Edit Delete  Undo plan Save plan

Mame - Time plan Workcode
Vacation with WS~ :

Day Schedule Day
Evening Schedule Evening
Night Schedule Might

Let's create a template to apply on the planning. We will name it as seen previously, but instead of creating a planning for the template, we will specify a
time range in the ‘Time plan’ cell.

Ol O

Delete  Undo plan Save plan

Name - Time plan Workcode
Vacation with WS oz T e
Day Schedule Day
Evening Schedule Evening

Might Schedule Night

This range has to cover the work schedule linked to the employee. In our work schedule example the employee’s work schedule runs from 9:00 to 17:00
We can fill-in 9:00-17:30 in the time plan cell. If you want to cover all types of work schedule, you can fill-in '00:00-23:59' in the ‘time plan’ cell

® @ ® 9 A

Delete  Undo plan Save plan

Mame .- Time plan Workcode
Vacation with WS 00:00-23:59

Day Schedule Y
Evening Schedule Evening
Night Schedule Might

We do not need to create a new work code for this template, we only need to select standard ‘Vacation’ work code. Save your template by clicking on the
“Save plan” icon on the right side of the screen



After that, we only need to select the vacation days on the planning, and drag and drop our vacation template.

2 P.Jansen 30/06 0107 0207 0307 04/07 05/07 08/07
Week 27

e U?IO? l” osm? l” ogm? l” mm;’ l” 11‘ro? l” um? 13!0?
Week 29 | BRECE [ BECCE T BNECE | WRECE | WEEL 7
“1IR IR IR IR IR
A B B B e -

Employees with planning:

Description

Vacation July

Workcode
Vac P

21/07/2014 08:00 - 12:00:
21/07/2014 13:00 - 17:00:
22/07/2014 08:00 - 12:00:
22/07/2014 13:00 - 17:00:
23/07/2014 08:00 - 12:00:
23/07/2014 13:00 - 17:00:
24/07/2014 08:00 - 12:00:
24/07/2014 13:00 - 17:00:
25/07/2014 08:00 - 12:00:

To plan vacation for an employee working with a planning, drag a template that you already use for this employee over the days you want to set as vacation
days. When the pop-up window appears change the work code to ‘Vac.P'.

Alternatively, you can also create a template with the correct number of hours linked to the ‘Vac. P’ work code.

2.3 SICK LEAVE (TA™ SOFTWARE VERSION ONLY)

Keeping trace of sick leave: there are 2 possible scenarios: the employee already has a work schedule or planning, or you have to make your planning
knowing that an employee is on sick leave. Manage sick leave on the clock grid:

E Go to the ‘Clock grid’ page, and select the absent employee.

Select the day(s) when the person is sick and right-click.

Select ‘Copy schedule to attendant records’, a new window will pop-up. In the work code drop-down list, select the pre-defined ‘Sick’ work code, and click
on OK.

Mame

1 John

Workcode

Bick

Your employee is now registered as sick for the selected day (s).



2.3.1 MANAGING SICK LEAVE IN THE PLANNING

Proceed as if you were going to plan regular working hours. When the confirmation window pops-up, change the work code to the standard ‘Sick’ work
code.

Your employee’s sick leave is now managed.

2.4 AMENDING OVERTIME (TA" SOFTWARE VERSION ONLY)

Over the year, your employees may accumulate overtime hours. The “Amend overtime” function of the software will help you manage these overtime-hours.
Go to the User page (ALT + E + U), and select the user for whom you want to amend the hours. Click on the “Amend” icon, a new window will pop-up.

,/

Edit Save Cancel

User ID

Fingerprints

JORE

Click on the “Amend” icon in the top bar of the user information tab

®IN




You can select a type of amendment: Paid hours: the hours are deduced from the overtime balance, they are shown as “paid hours” on the report.
Vacation hours: the hours are deduced from the overtime balance and added to the vacation balance. Other hours: the hours are deducted from the
overtime balance. You can enter a remark to give more details on the report. Click on OK when finished.

NB: if you want to add hours instead of deducting, place a minus (-) sign before the amount of hours.

@ Vacation hours : 2:007
Dl

A window will pop-up, prompting you to confirm your choice.

You will see list of all amendments made in the report page.

Amendments

Value Type Updater Comment

2:00 Wacation Jean Added 2 vacation hours
200 Faid Jean

Sum Faid: 2:00 ‘acation: 2:00

3. SCREENS OVERVIEW

3.1 PREFERENCES

The Preferences screen can be accessed through the menu bar by clicking on File and Preferences (keyboard shortcut: ALT + F + P).

000

S R - @)Safesoan

e
Presence lock g i Period Report o Department User Work Schedule Planning Jevice Workcode

Add Delete Undo Save

Settings IniOut translation
Region Function State InfOut

Meeting 5 In
Language
English B In 0 In

Sortie 1 Out
Actions

Pause 2 Break

Close year... Retour 3 Return

OT-IN 4 Ignore MNew Software Con...

Database

Database connection

192.168.66.122:c:\database\tadata fdb

Back up
Back up to disk Restore from disk
Automatic backup file Backup file location
Yes B ci\database\backupta.bak




3.1.1 SETTINGS

9 £3

Undo Save

Settings

Region

Language
{Englizh H v |

Click on Undo to reverse your changes, or on Save to save them. Those
two buttons apply to Region, Database, and Back up.

Actions

Close year...

Region: Select the language for your software.

Action: Close year (TA+ only) The Close Year action allows the transfer of all overtime and vacation hours from the previous year to the current year. After
clicking on the “Close year...” button the software will generate a report of the modifications. NB: this action cannot be undone. Please make sure that

the data from the previous year is correct.

Database

Database connection

192.168.66.122:c \database'\tadata.fdb

Back up

Back up to disk Restore from disk

Automatic backup file

Mo B

Backup file location

Database The database connection string determines the path to the
database of the software. The default value is: \TADATA.FDB

For more information regarding the database system used by the software,
please refer to the Firebird database section in the Appendix of the
present document.

3.1.2 IN/OUT TRANSLATION

Back up It is possible to create a backup-file of your data. This backup
can be done manually or automatically.

The In/Out translation table allows the software to deal with the actions performed with the customisable function keys of the Safescan TA-900 and TA-
8000 series terminals. For information regarding the setup of the customisable function keys of the terminal, please refer to your terminal’s manual.

Add Undo Save ® ﬁ &
iniut transiation Add Delete Undo Save
Functi Stat In/Out Workcode . . . . .

aneton = o Add a new item in the In/Out translation table: Click on the Add icon
Entrée 0 In located on top of the table, a new line will appear.
Sortie 1 Qut
Pause 2 Break
Retour 3 Return
Ignore 4 Ignore
In/Qut translation In/Qut translation
Function State -~ InfOut Workcode Function State = InfOut Workcode
Meeting| Meeting 4
In 0 In In 0 In

In the function column, give a name to the item (you may want to use the
same name as the one you entered in the terminal).

In the state column, report the state you entered in the terminal.




In/Qut translation IniOut translation

Function State » InfQut Workcode Function State =« In/Cut Workcode
Meeting 5 | Meeting 5 In
In
I 0 In 0 In
! Out
Out 1 Break
Return
Break 2 Ignore
In the In/Out drop-down list select the desired value. Choose the work code you want to associate to the clocking action.
In/Out translation
O ® ﬁ Function State « InfCut Workcode
Meeting|
Add Delete Undo Save In 0 In
Click on the Save icon located on top of the table. Edit an existing item in the In/Out translation table: Double-click on the
data you want to edit, enter the new data.
Add Delete Undo Save

Click on the Save icon located on top of the table.

3.2 L0G

The Log screen can be accessed through the menu bar by clicking on File and Log (keyboard shortcut: ALT + F + L). The log screen displays the actions
that have been performed on the device. This can be used by Safescan’s technical support for troubleshooting.

3.3 CLOCK

The Clock screen can be accessed through the menu bar by clicking on Edit and Clock (keyboard shortcut: ALT + E + C). The clock screen displays all
clocking data as a list. From here you can check, edit, and add clocking data. Anytime an error is detected by the software, the In/Out state of the line with
a suspected error will be highlighted in Red. It is important to realise that the software can only provide valid calculation results if it is fed with coherent
data. The following sequences are considered as “valid” by the software:

* In- Out
¢ In - Break - Return - Out
¢ In with work code - In with work code

* In-Inis also considered as valid, even though red highlights will be displayed. All odd Ins are considered as “In", all even Ins are considered as “Out".

Please note: In order to protect the employer and the employee, it is not possible to delete clocking data from the database of the software.

A clocking item can be set as ignored so that it is not taken into account for the hours calculation.

Edit Clock time. There are several ways to edit a clock time:

Taulis pets R )
= R ]
- P Add clock fime
- R wi
- e ChangetoIn
N / r ? Change to Qut
i, . J Change to Break
Lo ¢
Change to Return
i i d di -
Mail Print Ad Edit Refresh W e
a) Double click on the line you want to edit; b) Select the line to edit and or ¢) Select the line to edit, right click and click on “Edit clock time".

click on the Edit Icon located on the top right side of the screen;



3.3.1 ADDING A CLOCK TIME

There are two ways to add a clock time:

o

Refresh

= & (D ¢

Print Add E

You can either click on the “Add” icon located on the top right side of the
screen,

Name

When Time InfOut

07/08/2014 v In n
Device Workcode

TA 8035 (192.168.66.156)

Remark

Taahauets e ]
S T s
- Fomam Add clock time
o e w0 D
- L Change to In
- Change to Out
Change to Break
L 7
Change to Return
e Change to Ignore

or right-click directly in the list.

Name

45 Smith

Time

B 12:40

InfOut
In

When
07/08/2014
Device Workcode

TA 8035 (192.168.66.156)

Remark

Both operations will open a new pop-up window.

3.4 CLOCK GRID (TA" SOFTWARE VERSION ONLY)

Enter all data and press OK to insert the clock time. Note: The OK button
will only become active when all data has been entered.

The Clock Grid screen can be accessed through the menu bar by clicking on Edit and Clock Grid (keyboard shortcut: ALT + E + L).
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The Clock Grid screen displays all clocking data, as well as work schedule hours and planned hours. It gives a simple and straightforward view over the

“ins” and “outs” of your employees. The screen is divided into three different sections:

1 The filters: for more information regarding the filters of the software, please refer to chapter 1.4 of this manual.
2 The main part of the screen: displaying the clocking data as well as the planning and work schedules.

A red exclamation mark is displayed anytime the software detects errors in the clocking sequence.
3 The work code legend: Shows the colours and the names of the different work codes.

[ — You can choose to display this section, or not, by clicking on the “Workcode"icon located on the top-right side of the filter section.

3.0 DEPARTMENT

The Department screen can be accessed through the menu bar by clicking on Edit and Department (keyboard shortcut: ALT + E + D). You can find more
information regarding the creation of departments in chapter 1.7 of this manual.

3.6 USER

The User screen can be accessed through the menu bar by clicking on Edit and User (keyboard shortcut: ALT + E + U). You can find more information
regarding user creation and management in Chapter 1.8. On top of your users’ “Ins” and “Outs” management the TA and TA+ software offers some
useful user management features. User information is displayed on four tabs: System data tab: You will find on this tab all information necessary for the
communication with your

£ 49

Save Cancel

User ID Int. email Privilege Status
2 pmanfred@mycompany.com Administrator [l Active - |
User name Work schedule RFID No Fingerprints

Change
Paul Std B 12965875 Absent
Department Int. phone ®
Management 0156789453 Change password...

System data Personal data Work Time Vacation

TA terminal - please refer to Chapter 1.8.1 for the description of all common information between the software and the device.
Personal data tab: This tab displays contact information for the selected user. You can also fill-in the users’ birthday, and the “Joined company” and “Left
company” dates.

£a 49

Save Cancel
First name Street Private phone Birthday
Paul =
Last name Zip code / Postal code Mobile phone Joined company
Manfred 02/06/2014 B
Personnel no City Private email Left company
814-56 29/09/2014 [+ ]

System data Personal data Work Time Vacation

About the “Joined Company”date: The “Joined company” date has an impact on the calculation of the overtime (TA+ only). When a user starts in the

middle of the year, it is necessary to fill the start date, so the software can start all calculations with this date instead of the beginning of the year.




Work Time tab (TA+ only):

A3 Y9

Save Cancel

Annual working hours

Annual working hours. Nork time up to no Nork time remaining
0:00 186:26 -186:26
Waork time previous month

scheduled Overtime Hours taken Hours planned

186:26 187:00 -0:34 0:00 -1879:00

System data Personal data Work Time Vacation

This tab displays information regarding the hours performed. The tab is divided into two sections: “Annual working hours”, and “Work time previous month”.
In the “Annual working hours” section, you can set the number of hours an employee is supposed to work during a year. The “Work time previous month”
section displays the work time performed, the work time scheduled, the overtime, the hours taken and the ovetrtime history.

Save Cancel

From last year Correction Remaining vacation in hours

34:00 -1:00 33:00

Vacation in hours per year Special leave | Total hours of vacation for the current year

192:00 0:00 8:00 200:00
otal this and last year Tota nu
233:00

Hours taken Hours planned Hours remaining

42:30 25:30 165:00

System data Personal data Work Time Vacation

Vacation tab (TA+ only): It is possible to manage your employees’ vacations from this tab. Please note: Vacation data must be entered as hours: minutes.
From last year: You can fill-in the remaining vacation hours from the previous year. Correction: If you want to amend the vacation balance from the
previous year, you can do it in this field. To add hours, simply enter the numbers of hours you want to add (HH:MM). If you need to deduct hours, first enter
“-" (minus sign) before the number of hours you need to deduce (HH:MM). The total of the two previous fields will be displayed in the “Remaining vacation
in hours” field. Vacation in hours per year: Fill-in the number of vacation hours available for your employee for the year. Special leave: In those two
fields, you can add special vacation hours. The sum of the “Vacation in hours per year” and the “Special leave” fields will be displayed in the “Total hours of
vacation for the current yearfield. The total amount of vacation for the year is displayed in the “Total this and last Year”. Hours taken: Displays the number
of vacation hours already taken. Hours planned: Displays the number of vacation hours planned but not taken yet. Hours remaining: Displays the number
of vacation still available.

3.7 WORK CODE

The Work Code screen can be accessed through the menu bar by clicking on “Edit” and “Work Code” (keyboard shortcut: ALT + E + W). You can find
more information regarding the creation of work codes in chapter 1.10 of this manual.

3.8 WORK SCHEDULE

The Work Schedule screen can be accessed through the menu bar by clicking on “Edit” and “Work Schedule” (keyboard shortcut: ALT + E + O). You can
find more information regarding the creation of work schedules in chapter 1.9 of this manual.

3.9 PLANNING (TA™ SOFTWARE VERSION ONLY)

The Planning screen can be accessed through the menu bar by clicking on “Edit” and “Planning” (keyboard shortcut: ALT + E + P). You can find more
information regarding planning, creation and management on chapters 2.1 and 2.2 of this manual.




3.10 DEVICE

The Device screen can be accessed through the menu bar by clicking on “Edit” and “Device” (keyboard shortcut: ALT + E + E). Adding a new device on
the network or using a USB stick is explained in chapter 1.6 of this manual.

ol G © 4 ® <

Delete Refresh

Scan Add

Name IP address Active Fetcher Comm key Device Language [n]
192.168.66.120 192.168.66.120 Connected OFFICE] Dtk 4

D

Name

192.168.66.120

1P address of device

192.168.66.120

Fetching computer name
QFFICE-PC This computer

_I Communication key Device Language:

7 Q.l 0 Other g
= o

Synchronize

Set time Synchronize \yorieodes

1-Action bar: Depending on your device, and depending on how your device communicates with the software, some icons will be active or inactive.
Synchronise TA-655 logs: Allows to retrieve the logs from a Safescan TA-655 terminal. When the operation is done, you will be asked if you want to
delete the logs from the device. With the memory of this machine being limited, it is recommended to delete logs every time they have been transferred
into the software. Set Time: If you are using LAN or WiFi to establish communication between your Computer and your TA device, pressing this button
will set the time of your computer on your device. Synchronise: Synchronise user data between the software and the terminal(s). For more information
regarding the synchronisation of users, please refer to chapter 1.8 of this manual. Synchronise Work Codes: TA 900 series and 8000 series only. Send
all the work codes from your computer to the device. Get logs from USB drive: If you are using a USB stick to establish communication between your
computer and your TA terminal, pressing this button will trigger the reading of the attendance log file present on the USB stick. Device details: Provides
information over a specific device. Name: this is the display name of the device. IP address: the IP address of the terminal, leave this field empty when
using a USB stick. Fetching computer name: the name of the computer handling the communication between the device and the database. In most
case the fetcher should be the computer running the TA software. Communication key: it is possible to enter a numeric key to secure the connection
between the device and the software. Device language: this option allows the terminal to adapt to some languages specifications. This computer
button: sets the current computer as the fetching computer.

3.11 PRESENCE

The Presence report screen can be accessed through the menu bar by clicking on “Report” and “Presence” (keyboard shortcut: ALT + R + P). If your
device is connected to the network, the Presence screen allows you to see in real time the presence of your employees.

BG¢

Period Report
Presence User.... Department User
All 1~ Alr B Al 28 users - ® m 0
Export Mail Print Refresh
o User name -+ Firstname  Lastname Present In/Qut Work code # Work code Device name
5 Bob @ out
2 Eliott @® Out
50 Frederic ® I In 192 168 66.120
9 Jean @® In In " Cst.Vst. 192.168.66.120
51 John @® Out
T Linday @® out
14 Luke Break Break 192.168.66.120
4 Paco @® Out
6 Robert @® oOut
16 Sophie @® In In 192 168 66.120
12 Tara @ Out




Please note : An employee will be shown as “Out” automatically after a safety period of 96 hours without clocking data.

O S [

e
Presence Clock Clock Grid Day Period Report lep0 Department User W edule Planning

Report range Report from Report to End of day @ M 0

Today B 11082014 B 11082014 B o000 B v Work schedule on / off

User Depanmenl User Export Mail Print Refresh
All B Al 28 users - |

User ID User name Date Date In - Qut Work schedule  Duration Balance Days Breakin Breakout  Duratio... Remarks

16 Sophie 11 August 2014 11/08/2014 09:02 14:00 4:58 4:58 4:58
50 Frederic 11 August 2014 11/08/2014 08:30 18:42 8:00 947 1:47 9:47
14 Luke 11 August 2014 11/08/2014 08:25 1011 1:46 1:46 1.46
2 Eliott 11 August 2014 11/08/2014 0:00

The day screen report displays information one day per line. By default, the screen displays the first In and the last Out in the In and Out columns. All other
In/Out data is located in the Break In/Break Out columns. It is also possible to display the work schedule and the balance between the work schedule and
the clocked hours. The first line of the table gives different information: in the “In” column you will get the average In time, in the “Out” column the average

Out time. In the “Duration” column is displayed the total of all durations in the table. The “Days” column displays the number of worked days.

Please note: If something seems incorrect in the report, there is a strong chance that something is wrong with the clocking data. You can look for any

errors on the Clock screen, and correct them.

3.13 PERIOD

The Period report screen can be accessed through the menu bar by clicking on “Report” and “Period” (keyboard shortcut: ALT + R + E). The Period report
screen displays information for a given period , one line per user.

L D & = @smescan

Presence Clock Clock Grid Jay Period Report - Department User chedule  Planning
Report range Report from Report to End of day @ M o
Last month B 010772014 B 31072014 B 0300 B | Work schedule on / oft
User Departmem. User Export Mail Print Refresh
All B Al 28 users -

User D User name: Department Work sche... Duration Balance 01/07/2014 0200772014  03/07/2014  04/07/2014 0S5/ . 0707/2014  08/07/2014  09/07/2014 10/0712014 1140712014 12107120

50 Frederic Marketing 71:58 71:58 08:00 08:00 08:00 01:09 10:42 1733 08:00 08:00

2 Eliott Marketing 117 17

Please note: If something seems incorrect in the report, there is a strong chance that something is wrong with the clocking data. You can look for any

error on the Clock screen, and correct them.




3.14 REPORT

The Report screen can be accessed through the menu bar by clicking on “Report” and “Report” (keyboard shortcut: ALT + R + R).

8060

T4 File Edit Report Help

Ao -_ RIS & @Safescan

v de
Presence Clock Grid Jay Period Report Department User Wo dule Planning
Report range Report from Report to End of day Options @ M 0
Last manth B 01/07/2014 B 31072014 B 0500 B Vacation
Overtime = i .
| port Mail Print Refresh
User... Department User | Too latelearly
All B All16 users B  Amendments
11 August 2014 - 1/20
Date: 11-08-2014 Monthly report 01-07-2014 - 31-07-2014
Time: 14:48 05:00
Name: Fred Henrich m:1 Work schedule: Std
Department: Management Personnel no: 123-32
Date  Day In out Roster Hours Balance| Cumm.| Absent|Remarks / Work code
0107 Tue %00 12:00 8:30 &30
1230 18:00
0207  Wed 900 12:00 8:30 &30
1230 18:00
0307 Thu 900 12:00 8:30 &30
130 18:00
04:07  Fri 745 12:00] 8:30 945 115 1:15] -| comected by systam
1230 18:00
0507 Sat - - - - - 1115]
0507  Sun - . . . . 1:15]
Week 27 34:00 35 u1S
07:07  Men %34 1200 8:30 €52 -n3s|  -0:23]
1230 16:5
0807  Tue 900 12:00 8:30 &30 - -0:23]
1230 18:00
0907 Wed 900 12:00 8:30 &30 - -0:23]
1230 18:00
1007 Thu 900 12:00 8:30 &30 - -0:23]
130 18:00
107 Fd 814 12100 8:30 819 01 0134
1230 17:03
12:07  sat - - - - - 0134
1307 Sun - . . . . 0134,
Vieek 28 42:30 404 149
14:07  Mon - - - - - -0:34] £:30|Holiday
1507 Tue 00 12:00 8:30 830 - 0134,
11/08/2014 14:48 EATA 965 (192.168.65.171) BB TA-855 (192 168.66.114) £

The Report screen allows you to generate reports for any given period in an easy to read layout. You will see the Ins and Outs, the daily, weekly, and
monthly hours and balance (if the user is linked to a work schedule), and any remarks you have filled in”, or left by the system. If you are using the TA+
software, you will also have the possibility to display the vacation and overtime hours and amendments, as well as the late arrival and early leave times.

Corrected by the system:
If you see “Corrected by the system” in the “Remarks” column of the report, it means that some clocking information is missing for this specific day, and

that the software took the information of the work schedule to make the calculations.

Please note: If something seems incorrect in the report, there is a strong chance that something is wrong with the clocking data. You can look for any

errors on the Clock screen, and correct them. Please note: Clicking on the “Export” icon from this page will not generate a .CSV file, but a .PDF file.

3.10 WORK CODE REPORT

The Work Code Report screen can be accessed through the menu bar by clicking on “Report” and “Work Code” Report (keyboard shortcut: ALT + R +
W). The Work Code Report screen allows you to see the amount of time spent on specific tasks or projects. The results can be grouped by day, person or
work code.

3.16 ABOUT

The About screen can be accessed through the menu bar by clicking on “Help” and “About” (keyboard shortcut: ALT + H + A). The About screen displays
information the version of your software, and provide several links to Safecan’s website (Online help, Manual, Support, and Updates).




APPENDIX

SUPPORT

If you experience issues/problems with the software, and need help from Safescan’s technical support, click on Help and select Support (keyboard

shortcut: ALT + H + S), this will launch the Safescan remote support software (TeamViewerQS). Call the phone number displayed on your screen and
provide your ID and password to our technicians.

E Safescan remote support EI@

@j Safescan

Allow Remote Control &

Please call =31 85 486 77 77, and provide the
following ID to our support team.

k71 917 868

Ready to connect [secure connection)

www. teamviewer.com Cancel

FIREBIRD DATABASE

The TA software uses a Firebird embedded database. It is possible to copy this database and install it on any computer provided that it is running
the Firebird Server software. After having changed the location of the database, you need to change the connection string in the software: Go to the
Preference screen, in the database connection field, enter the new address of the database. Click on save. The software needs to be restarted.

For more information regarding the use of Firebird Server with your software, please contact our technical support.

UPDATES

Safescan is constantly working to offer you a better user experience. We regularly release updates for your software, improving current features or adding

new ones. Every time an update is released, your software will give you a notification. We advise you to install these updates as soon as they are released.



